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Typography 

We will be using the following typography to distinguish items in the text: 

 [Enter]  Brackets indicate keys on the keyboard. 

flexibility Italics are used to highlight words for more emphasis. 

Lot 2  Numbers or text that you enter. 

System Requirements 

This version of TPC Desktop requires Windows 10 / 8.1 / 8 / 7 / Vista and Internet Explorer 
Version 6.0 or later.  We recommend you have 2 GB of RAM 32-bit OS) 4 GB RAM (64-bit 
OS) and 60 MB of free hard disk space in which to install the program.  An internet 
connection is required for program validation. 

Important Licensing Information 

Our License Agreement allows you to use TPC on only one computer at a time unless you 
purchase additional licenses. We do offer one courtesy installation for an additional home or 
field computer, but not for a second user and assuming that the two programs are not being 
used at the same time. To request a courtesy license contact Traverse PC. 
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Traverse View Formats 
 

¤This chapter demonstrates: 

ü Included Formats 

ü Display Sequence 

ü Edit Sequence 

ü OP Sequence 

ü Other Options 

ü Saving and Recalling Formats 

Overview 

The Traverse View is designed on a spreadsheet format to allow you to enter, edit and review 
data however you choose.  It is completely user-customizable so you never have to settle for 
doing things the way someone else thinks you should do them.  It can display any number of 
fields so you can see at a glance any information you need.  This makes it an extremely 
powerful and flexible data management tool. 

In this chapter, you will learn how to use the formats that come with your program, how to 
change these formats, and how to create your own.  This will allow you to make maximum 
use of TPCôs data tools in the Traverse View. 

¤Getting started 

1) From the Tasks Manager , choose Sample Surveys. 

2) Double-click the LEARN FORMATS.TRV  file then choose File | Save Survey As. 

3) Enter the name Formats and choose Save. If prompted to replace the existing file, choose 
Yes. 
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Included Formats 

Traverse PC includes several Traverse View formats to help you get started quickly and 
easily.  These are great starting points for learning how the Traverse View works and for 
deciding what you want to include in your own formats.  These formats have names that 
describe their function in order to help you know which one to use for each traverse.  They 
are: 

Alignment 
Boundary 
Control 2D 
Control 3D 
Coordinates 
Deed 

Deed w/curves 
Default 
Foundation 
GLO 
GPS 2D 
GPS 3D 

PLSS 
Profile 
Topo w/benchmark 
Topo w/HI 
Xsection 

 

The first time you open any traverse in TPC Desktop, you will see the Traverse dialog. Enter 
a Name, Format and Settings. If you are entering data from a deed description, you might 
choose Deed for the Format and Property Lines for the Settings. If there are curves in the 
deed description, the Deed w/curves format should do the trick. 

1) In the Traverses Manager, 
choose Tools | Insert New 

Traverse | Append to End. 

2) In the New Traverse dialog 
type Deed Data in Name 
and choose Deed w/curves 
and Property Lines from 
their respective lists. 

3) Choose OK . 

Your Traverse View should 
now look something like this. 
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Each Traverse View format provides you with different options. Letôs take a look at what is 
available in each of the standard formats.  Keep in mind that you can change these formats 
or create your own formats to suit your needs. Each format includes a Point and Type 
column, followed by the following: 

Alignment  Bearing| HorizDist| Station| Radius| ArcLength| Delta| Northing| Easting| Elev| Desc 

Boundary  Bearing| HorizDist| Radius| ArcLength| Delta| Northing| Easting| Elev| Desc 

Control 2D SlopeDist| ZenithAngle| HorizAngle| Northing| Easting| Elev| Desc 

Control 3D SlopeDist| ZenithAngle| HorizAngle| TargetHt| InstrHt| Northing| Easting| Elev| Desc 

Coordinates Northing| Easting| Elev| Desc 

Deed  Bearing| HorizDist| Northing| Easting| Elev| Desc 

Deed w/curves Bearing| HorizDist| Radius| ArcLength| Delta| Northing| Easting| Elev| Desc 

Default Slope Dist | Zenith Angle | Horiz Angle | Instr Ht | Northing | Eaasting | Elevation | Description | 
Target Ht 

Foundation NorthAz| DeflecAngle| HorizDist| Northing| Easting 

GLO  True Bearing | Geo Dist | Elevation | Latitude | Longitude | Converge 

GPS 2D  Desc| Northing| Easting| Latitude| Longitude 

GPS 3D  Desc| Northing| Easting| Elev| Latitude| Longitude| Height 

PLSS  True Bearing | Geo Dist | Elevation | Latitude | Longitude | Converge 

Profile  Station | Elevation | Description 

Topo w/benchmark SlopeDist| ZenithAngle| HorizAngle| TargetHt| InstrHt| Northing| Easting| Elev| Desc 

Topo w/HI SlopeDist| ZenithAngle| HorizAngle| TargetHt| InstrHt| Northing| Easting| Elev| Desc 

Xsection  SlopeDist| Percent| Elev 

Note:  Every format starts with Point and Type even though they are not shown here.  These 
fields are included automatically in every format, even the ones you create. 

If you havenôt changed anything since you opened the Deed Data traverse, the active field 
should be the Point label 11.  Press your [Enter] key and the active field is now Type.  [Enter] 
again and you are in Bearing.  [Enter] once more and you are in Horiz Dist .  [Enter] again and 
you are in Radius.  Again and you are in Arc Length.  Once again and you are now in the 
Bearing field for point 12.  At this point, you can hit [Enter] again and again and the active field 
will toggle between Bearing, Horiz Dist, Radius and Arc Length for point 12 until the 
appropriate data is entered.  This action is also controlled by the Traverse View Format and 
therefore by you. 

We will look at how you can make the Traverse View do what you need it to do. 
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Display Sequence 

The Display Sequence controls which fields are displayed in the Traverse View and the 
sequence in which they are displayed. 

1) Choose View | Format View 
and left-click the Format tab. 

2) These are the settings that are 
controlling how the Deed Data 
traverse looks and acts. They 
were set earlier when you 
selected the Deed w/curves 
format in the Traverse dialog. 

The Display Sequence determines 
which fields are displayed in the 
Traverse View. The list on the 
right tells you what each code 
does. The first two columns in the 
view (Point and Type) are 
automatically included before the 

codes that are set in the Display 

Sequence. Therefore, the Display 

Sequence BHRCYXD gives us a 
Traverse View with the Point, 
Type, Bearing, Horiz Dist, Radius, 
Arc Length, Northing, Easting and Description fields as we saw in our Deed Data traverse. 

3) To switch from Horiz Dist  to Slope Dist and Vert Angle, replace the H with SG in the 
Display Sequence. 

¤Hints 

Note that the codes in the chart are case-sensitive. The letter óCô gives you Arc Length but ócô 
gives you PC->PR.  Make sure you use the correct case (upper or lower) so that you get the 
fields you intended. 
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Edit Sequence 

The Edit Sequence controls which 
fields the cursor goes to 
automatically, in sequence when 
you press [Enter] or [Tab] in the 
Traverse View. 

The Edit Sequence BH tells us that 
the cursor will automatically move 
between the Bearing, Horiz Dist, 

Radius and Arc Length fields. 

¤Hints  

ü Do you remember the cursor 
toggling between the Bearing, 
Horiz Dist, Radius and Arc 

Length fields for point 12?  It 
did that because of this Edit 

Sequence. 

ü You can jump out of the Edit 

Sequence in the Traverse View 
at any time by using a cursor key or clicking in the field you want to edit.  Each time you 
press [Enter] or Tab, you will jump to the next field on the line until you get to one of the 
Edit Sequence fields.  At that point, you will jump to the next field in the Edit Sequence. 

To switch from Horiz Dist  to Slope Dist and Vert Angle. 

1) Replace the H with SG in the Edit Sequence. 
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OP Sequence 

The OP Sequence controls what point types are added to a traverse automatically following 
any occupied point. The first point in a traverse is always an occupied point but the OP 

Sequence determines what comes next. 

If you are entering data from a deed record, you will simply want to enter data from occupied 
point to occupied point. In this case, you want an OP Sequence of FS.   

If you are entering data for a topo and will be taking numerous sideshots from each occupied 
station, you would want BS/SS in the OP Sequence.  (Note that we have assumed that you will 
be entering a backsight to start.) 

If you will be entering a field traverse or a meander with very few sideshots, BS/FS should 
work well.  (Again we assumed that you will use an initial backsight.) 

¤Hints 

The OP Sequence is not a critical element of the Traverse View Format. You can change a 
point type at any time so if you have an OP Sequence of BS/SS but donôt want any sideshots 
from the first occupied point, simply change the first sideshot to an occupied point in the 
Traverse View. 

$ To learn more about changing point types in the Traverse View 

1) Choose Help | Search For Help Oné and left-click the Contents tab. 

2) Scroll down to Traverses and double-click it to expand it. 

3) Double-click the Traversing topic to expand it. 

4) Youôll find topics on Starting a Traverse, Entering Data, etc. 
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Other Options 

There are several other options available in the Traverse View Format dialog.  We will look at 
a few of the more important ones. 

$ To learn more about the other options not covered here 

1) Press the [F1] key from the Traverse View Format dialog Formats tab. 

¤Copy Descriptions 

This option copies any description from the previous point into the new point.  This can save 
keystrokes when you are entering several shots with the same or similar descriptions.  
Because you can edit the new description at any time, it is simple to change the description 
to what you need.  The new description is then copied to the next new point. 

¤Delete Raw Warning 

Traverse PC will display a warning when you try to delete a point 
that has raw data in this traverse.  You can still delete the point, 
but TPC is giving you a chance to change your mind if you really 
did not want to delete the raw data. 

 

 

$ To learn more about raw data and inverse data 

1) Choose Help | Search For Help Oné and left-click the Index tab. 

2) Scroll down to Raw data, highlight it and choose Display. 

3) Highlight the Displaying Raw Data topic and choose Display. 

 

¤Compute Latitude/Longitude 

If you will be using Latitude and Longitude in the Traverse View or if you will be entering 
State Plane coordinates and want to see the Latitude and Longitude in the Traverse View, 
you will need to open the Advanced tab. 

1) Choose View | Format View and left-click the Advanced tab. 

2) Turn on Compute Latitude/Longitude. 
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¤Single Row  

The Single Row option allows you to display more data in a smaller space on the screen.  
Without this option turned on, the Traverse View has more of the appearance of the typical 
field book. 

 
 

Single Row option on 

 

 

 

 

 

With the Single Row option turned on, each point takes up one line in the Traverse View.  The 
data on each line is the data that created that point.  (The Bearing and Horiz Dist on the Point 
2 line is the Bearing and Horiz Dist that was shot from Point 1 to Point 2.)  Depending on the 
Description Width  entered, there may not be enough room to display all of the Description. 

 
 

Single Row option off 

 

 

 

 

 

 

With the Single Row per Point option turned off, each point takes up two lines in the Traverse 
View to mimic the field book.  The data above each point number is the data that created that 
point.  (The Bearing and Horiz Dist above Point 2 is the Bearing and Horiz Dist that was shot 
from Point 1 to Point 2.)  Because two lines are available for each point, more of the 
Description can be displayed with less Description Width . 

Note that the Single Row option can also be turned on or off in the Traverse View by toggling 
the Single Row per Point option in the View menu. 
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Saving and Recalling Formats 

You can modify existing formats and save the changes or you can create entirely new 
formats. 

¤Saving a Format 

1) From the Traverse View Format dialog 
Format tab, choose Save Format. 

2) Type Deed w/Slope and choose OK . 

3) You could have selected one of the 
formats in the list and chosen OK. Your 
format would have replaced the format 
that was previously saved with that name 

4) Choose OK  from the Save Format dialog. 

¤Hints 

The Save Format dialog looks for a saved format that matches the format you are saving. If it 
cannot find a match, it displays Customé as the format name. 

 

5) Choose OK  from the Traverse View Format, Format tab to apply the changes to the 
Traverse View. 

¤Recalling a Format 

You can recall an existing format at any time.  Normally, you will choose the format when you 
initially create the traverse.  If you chose the wrong one or if you simply want to recall a 
different format along the way, you can do so easily. 

1) Choose View | Format View from the Traverse View and left-click the Format tab. 

2) Choose Recall | Format. 

3) Pick the format name you wish to recall and choose OK . You can also just start typing the 
name of the format and TPC will list any formats that match. 

4) Choose OK  from the Traverse View Format dialog. 

The Traverse View will now reflect the settings of the format you recalled. 
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Entering Record Data 
 

¤This chapter demonstrates: 

ü Starting a new survey 

ü Adding a traverse to a survey 

ü Entering record data 

ü Closing a traverse 

ü Entering curve data 

ü Viewing a traverse 

ü Checking lot closures 

ü Recalling common points 

ü Viewing a survey 

ü Reviewing surveys, traverses and files 

ü Ending a survey 
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Overview 

In this chapter, you will enter boundary data for two lots.  TPC will compute the closure error 
and area for each lot. 

¤Getting Started 

You will find that entering the lot dimensions is less confusing if you take the time to number 
the lot corners before you enter data.  In the following diagram, the corners are numbered 1 
through 8, starting with the southwest corner of lot 2. 

TPC does not need the lot numbers defined ahead of time.  As you enter data, it will 
automatically assign a number to each point.  However, in this example you will be using 
points created in one lot to define parts of adjacent lots.  If the lot corners are numbered 
ahead of time, you can refer to your map when determining which numbers to recall.  This 
should become clear as soon as you enter the data for lot 3. 
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Starting a New Survey 

1)  From the desktop menu choose File | New 

Survey and left-click the Survey tab. If you 
have a file open and have made any 
changes since you saved the current 
survey, TPC will ask if you want to save 
the current survey before you proceed. 

2) Click the Browse button, enter Record Data 
in the File name field and choose Save. 

3) TPC will re-display the Survey Information  
dialog with the correct path and Filename. 

4) Fill in the rest of the fields as shown here. 

5) Choose OK .  

  

The Survey Information  bar in 
the Tasks Manager displays the 
information you just entered for 
this survey. 

Any time you open this survey in 
the future, you can check this 
information in the Tasks 
Manager to make sure you have 
the survey you want. 
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Add a Traverse to the Survey 

You will start this survey by entering the data for the first lot, Lot 2. 

1) Double-click any blank line 
in the Traverses manager 
to display the New 

Traverse dialog. 

2) Type Lot 2 for the Name 
and press [Tab] to 
advance to the next field.  

3) Using the mouse, left-click 
the down arrow on the 
right side of the Format list 
to display the list of pre-
defined formats.  Left-click 
Deed w/curves. This pre-
defined format includes 
grid bearing, grid distance, 
radius, arc length, 
coordinates and 
description.  In a previous 
chapter you learned how 
to change these pre-
defined formats and add 
your own. 

4) For Settings, choose Property Lines. 

5) Match the Drawing Options shown here. 

6) Choose OK .  You will see the following Traverse View.  

Note: If you continue to select Deed w/curves for the Format of new traverses, TPC Desktop 
will start using Deed w/curves as the default. This is called sticky logic. 
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Entering the Lot 2 Data 

TPC displays 0.000, 0.000 as the coordinates of point 1.   

1) Press [Enter] until TPC automatically adds the next point (2) to the traverse and highlights 
the grid bearing to point 2. 

2) If the Drawing View is not displayed, initiate it by choosing Window | Drawing View from 
the desktop menu. This will allow you to watch the drawing develop as data is entered in 
the Traverse View. 

3) To see both views at the same time, choose Window | Tile Horizontally . 

4) Type 190 in the Grid  Bearing column for N 90°E and press [Enter] (when entering 
bearings, they are preceded by the quadrant 1=NE, 2=SE, 3=SW and 4=NW).  Type 
284.88 in the Grid  Dist column and press [Enter] three times to move to the Grid  Bearing 
to point 3. 

5) Enter 123.27 for the grid bearing, 163.5 for the grid distance to point 3 and [Enter] to the 
Grid  Bearing to point 4. 

6) Enter 390 for the grid bearing, 291.03 for the grid distance to point 4 and [Enter] to the Grid  

Bearing to point 5. 

7) Enter 330.4 for the grid bearing 14.08 for the grid distance to point 5 and [Enter] to the Grid 

Bearing to point 6. 

As you enter data, TPC computes the position of the foresight, adds another point to the 
traverse, automatically numbers the point by adding 1 to the previous point label and 
highlights the new point.  
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Closing the Lot 2 Traverse 

The last point that was added to this traverse was point 6. This is the closing point for this 
traverse.  It is a unique point with a unique set of computed coordinates.  This allows TPC to 
check for error in the property description.  If there were no error in the property description, 
the computed coordinates of point 6 would be the same as the initial point 1.  In fact, if there 
were no errors in the property description, you could recall point 1 to end the traverse.  If 
however, there is any error in the property description, and there usually is some small error, 
comparing the computed coordinates of point 6 with the coordinates of point 1 will identify 
how much error there actually is. 

In order to help you identify point 6 as the closing point and to identify it as being associated 
with point 1 we will change its point label from 6 to 1:1.  There is nothing special about the 
point label 1:1, itôs just a convenient notation. 

1) Highlight point label 6, type 1:1 and press [Enter] twice. 

2) Enter 320.341 for the grid bearing and 147.27 for the grid distance to point 1:1. 

Your Traverse View should look something like this. 
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Entering the Curve Data Between Points 5 and 1:1 

1) Highlight the Radius cell for point 1:1 and enter -420.  The minus sign is used to designate 
a counterclockwise curve direction.  

TPC will compute the curve, display the radius and arc length and display a PC and PT next 
to points 5 and 1:1, indicating that they are part of a curve. 

 

$ To learn more about entering horizontal curves 

1) Choose Help | Search For Help Oné and left-click the Index tab. 

2) Double-click Centerlines / Alignments. 

3) Left-click Entering Horizontal Curves. 

 

Viewing Lot 2 

As you have been entering data in the Traverse View, the drawing is being created in 
Drawing View. Youôll learn more about this in the Drawing Learning Guide. 

You may need to zoom the drawing to see the details shown here. 

1) In the Drawing View choose View | Zoom | Zoom Extents. 
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Checking the Closure and Area of Lot 2 

1) From the 
Traverse View 
menu choose 
Tools | Closure 

View.  TPC 
displays the 
Closure View 
for this 
traverse. 

 

The Closure View 
displays the linear 
error of 0.010 feet 
and the area of 
1.01 Acres along 
with Horizontal 

Distance, Slope 

Distance, Area and 
other information. 

 

¤Closing the Closure View 

1) Left-click the X in the upper-right corner of the Closure View. 

 

Closing the Lot 2 Traverse View 

1) Left-click the X in the upper-right corner of the Traverse View to close it. 

2) If TPC displays the Save Drawing Changes? 
dialog box, choose No. 

3) TPC will close the Traverse View and re-
activate the Drawing View. 

If you got this dialog, itôs because you opened 
this traverse with its own temporary drawing. In 
the next section youôll create a new traverse that 
shares the current drawing. 

¤Closing a Traverse View 

Even though the Traverse View for Lot 2 is now closed, the Lot 2 traverse and all of its data is 
still part of the survey. You can open the Lot 2 Traverse View any time by double-clicking the 
Lot 2 traverse name in the Traverses Manager. 
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Adding an Adjacent Lot to a Survey 

1) If the Traverses Manager is not the active view, left-click anywhere on it to activate it. 

¤Adding a traverse for Lot 3 

Before you can enter the data for Lot 3, 
you need to add a traverse to the survey 
to hold the data. 

1) From the Traverses Manager, 
choose Tools | Insert New Traverse | 
Append to End or press [Ć] until 
TPC adds a blank line to the 
Traverses Manager. 

2) Double-click the blank line or just 
press [Enter] to display the Traverse 
dialog. 

Because Increment Name for next 
traverse was turned on when we 
created Lot 2, TPC automatically 
created Lot 3 for the Name. 

The Format, Settings and Drawing 
Options are remembered from the last 
traverse, so there is no need to change 
them. 

3) Choose OK . 

¤Recalling the common points 

Before you start entering data for Lot 3 refer 
back to the diagram at the beginning of this 
chapter.  Notice that lots 2 and 3 have two 
points in common, points 3 and 4.  Since points 3 and 4 are already computed, you can start 
lot 3 by simply recalling these two points. 

1) Highlight the first point label in the new traverse if it isnôt already highlighted. 

2) Type 3 and press [Enter].  TPC will display a dialog telling you that this point already 
exists. 

3) Press [Enter] to recall the existing point and its coordinates. 

4) TPC will automatically add a second point to the traverse and move the cursor down to it. 

5) Type 4 and press [Enter] twice. 

Now that you have recalled points 3 and 4 into the traverse, you can enter the rest of the lot 
data, starting with the course from point 4 to 6. 
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6) Press [Enter] until the grid bearing to point 6 is highlighted. 

7) Enter 130.4 for the grid bearing and 32.44 for the grid distance to point 6.  Press [Enter] 
until TPC adds point 7 to the traverse. 

8) Press the right arrow key on your keyboard until you are in the Radius cell for point 7. 

9) Enter -430 for the Radius.  The minus sign indicates a curve with a counterclockwise 
direction.  Then enter 134.61 for the Arc Length.  As soon as TPC has enough information, 
it computes the curve.  Because curve data was entered instead of a bearing and 
distance, TPC assumes that the curve is to be a tangent curve as shown in the Drawing 
View window. 

10) Continue pressing the [Enter] key until the cursor moves to the Grid  Bearing cell for point 
8. 

11) Enter 190 for the grid bearing and 291.05 for the grid distance to point 8.  Press [Enter] 
until TPC adds point 9 to the traverse. 

12) Highlight point 9, type 3:1 and press [Enter].  This re-labels the closing point of the 
traverse to 3:1.   

13) Press [Enter] until the Grid Bearing to point 3:1 is highlighted. 

14) Enter 323.27 for the grid bearing and 166.2 for the grid distance to point 3:1. 

 

 

 

 

 

 

 

¤Checking the closure 

1) From the Traverse View menu choose Tools | Closure View.  Does your Closure View 
report 0.011 feet of linear error in the lot data? 

2) Click on the X in the upper right corner of the Closure View to close it.   
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Viewing the Survey 

Both of the traverses you just created were 
tagged when they were created in the Traverse 
dialog. 

Only tagged (checked) traverses are displayed in 
the Drawing View. This allows you to view 
selected traverses while hiding others.   

Ending the Survey 

¤Saving your changes 

You have made several changes since the 
survey was saved. 

1) From the desktop menu, choose File | Save 

Survey. 

2) Choose OK  when TPC tells you the file has 
been saved. 

¤Exiting TPC 

1) To exit TPC, choose File | Exit.  If TPC 
detects that changes have been made to the 
survey since the last time you saved your file, 
TPC will ask you if you want to save your file.  
Choose Yes. 

 

Reviewing - Traverses, Surveys and Files 

Now that you have created a survey with traverses and saved it to a file, reviewing what 
Surveys, Traverses, Points and Files are should help. 

You have created one survey named Plat Check, which is saved in a file named Record 

Data.trv . The survey is composed of two traverses named Lot 2 and Lot 3. The Lot 2 and Lot 

3 traverses contain points 1 through 8 and points 1:1 and 3:1 which can be viewed in the 
Points Manager. 

The survey name is Plat Check. 

The survey file name is Record Data.TRV. 

The traverse names are Lot 2 and Lot 3. 

The points are 1 ï 8, 1:1 and 3:1. 
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Entering Field Data 
 

¤This chapter demonstrates: 

ü Adding a field data traverse to a survey 

ü Entering field data 

ü Entering sideshots 

ü Traversing ahead 

ü Traversing ahead using a different backsight 

ü Viewing the field data 

ü Viewing the survey 

ü Translating the field data to record data 

ü Rotating the field data to record data 

ü Checking the results 

ü Ending the survey 

 

 

 

 

 

 

 

 

 

Overview 

In this chapter, you will 
enter field data for the two lots you entered record data for in the chapter on Entering Record 
Data.  You will rotate and translate the field data to the record data and check the results. 

¤Getting started 

1) From the Tasks Manager , choose Sample Surveys. 

2) Double-click the LEARN FIELD DATA.TRV  file. 

3) Choose File | Save Survey As then enter the name Field Data and choose Save. 

4) If prompted to replace the existing file, choose Yes. 
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Add a Traverse to the Survey 

You will start by entering the field data. 

1) At the Traverses Manager, double-
click in blank space to bring up the 
New Traverse dialog box. 

2) Type Field Data for the Name.  

3) Using the mouse, left-click the down 
arrow on the right side of the Format 
list to display the list of pre-defined 
formats.  Left-click Control 2D.  We 
will modify this format to meet our 
needs. 

4) From the Settings list choose Control 

Loops. 

5) Choose Create temporary drawing. 

6) Choose OK .  You will see the 
following Traverse View.  

7) Choose View | Format 

View and left-click the 
Format tab. 

8) Change the Display 

Sequence to BSFYXD 
and the Edit Sequence to 
SFD. 

9) Turn on Copy 

Descriptions to New 

Points and choose OK .   

You will see the following 
Traverse View. 

$ To learn more about Traverse View formats 

1) Choose Help | Search For Help Oné and left-click the Index tab. 

2) Scroll down to Traverse View Formats, highlight it and choose Display. 
















































